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7.  OPTIMALITY THEORY AND SYNTACTIC TYPOLOGY

(1) STAY: Trace is forbidden
(2) OP-SPEC: Syntactic operators must be in specifier position

OP-SPEC STAY
+Whoi did you see ti *
You saw who *!

Tableau I: A language with overt Wh-Movement:

STAY OP-SPEC
Whoi did you see ti *!
+You saw who *

Tableau II: A language without overt Wh-Movement:

(3) CASE: Move NP to a case-licensing position (canonical subject or object
position)
(4) WEIGHT: Postpose heavy NPs

(5) a.  Mary regards John fondly.
b.  ?Mary regards fondly John.
c.  ?Mary regards all the students in her class in optimality theory fondly.
d.  Mary regards fondly all the students in her evening class in optimality

theory. (WEIGHT outranking CASE)

WEIGHT CASE
+ [[S V [VP Adv t] [Heavy NP] *
[S V [AgrOP Heavy NP [VP adv t t]]] *!

Tableau III
Weight effects dominating the Case requirement in English

(6) PURITY OF EXTENDED PROJECTION (PURE-EP): No adjunction takes
place to the highest node in a subordinate extended projection; and no
movement takes place into the highest head of a subordinate extended
projection.
(7) CASE MARKING (CASE): DPs must be Case-marked
(8) OBLIGATORY HEADS (OB-HD): A projection has a head.
(9) ECONOMY OF MOVEMENT (STAY): Trace is not allowed

This ranking conspires to block movement:
Candidates (subordinate
interrogatives)

PURE-EP CASE OB-HEAD STAY

[CP who shouldi [IP we ei[VP see t]]] *! **
+ [CP who e [IP we should [VP see t]]] * *
[IP who should [VP we see t]] *! *

Tableau IV: The surfacing of a low-ranked constraint
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A. THE RESTRICTIVENESS PROBLEM . One frequently encounters the
claim that a particular OT analysis is in some interesting sense ‘restrictive’, that
is, that it follows from the analysis that logically possible, but nonoccurring,
language types are excluded. Such claims tend to be  empty.
B. THE FUNCTIONALITY PROBLEM. I discuss the attempt to provide
substance to the idea that constraints are universal by requiring for each a
functional motivation — and in that way uniting formal and functional
linguistics. I argue that while identifying a ‘function’ for each OT constraint is
trivially accomplishable, it is an undesirable ‘accomplishment’.

(10) DROPTOPIC: Leave arguments coreferent with the topic structurally
unrealized. [failed by overt constituents which are coreferential with the topic]
(11) PARSE: Parse input constituents. [failed if an element of the input does
not appear in the output] PROHIBITS NULL ELEMENTS
(12) ALIGN FOCUS: Align the left edge of focus constituents with the right
edge of a maximal projection. [failed by non-aligned foci]
(13) FULL-INTERPRETATION Parse lexical conceptual structure [failed by
expletives and auxiliary do]
(14) SUBJECT: The highest A-specifier in an extended projection must be filled
[failed by clauses without a subject in the canonical position]

Input: <gridare (x), x=focus, x=Gianni>
Candidates DROP

TOPIC
PARSE ALIGN

FOCUS
FULL
-INT

SUBJECT

+ha gridato Gianni *
Gianni ha gridato *!
ha gridato,, Gianni *! *
ha gridato (CAN’T GET) *! *
[null structure] *!*
expl. ha gridato Gianni *!

Tableau V
Italian focused subjects (Grimshaw and Samek-Lodovici 1998)

(15) DROPFOCUS: Leave arguments coreferent with the focus structurally
unrealized. [failed by overt constituents which are coreferential with the focus]

Input: <V (x), x=focus, x=DP>
Candidates DROP

FOCUS
DROP
TOPIC

PARSE ALIGN
FOCUS

FULL-
INT

SUBJECT

AUX V DP *! *
DP AUX V *! *!
AUX V,, DP *! *! *
+AUX V * *
[null structure] *!*
expl. AUX V DP *! *!

Tableau VI
The derivation of null focused subjects
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(16) Q: Who broke the plate?
A: You know who!

(17) Q: Who broke the plate?
A: e broke the plate. (INTERPRETATION: ‘You know who broke the

plate’)

(18) Q: Quem é que partiu o prato? (Portuguese)
A: Partiu o prato?

(19) Q (asked by somebody who most likely did it, but is trying to cover it up):
Tko je razbio c&as&u (Serbo-Croatian)
Who broke the glass?

A (With an ironic intonation):
Razbio, razbio
Broke, broke (interpretation: ‘You know who did it — it was you’)

name grammatical constraint corresponding user constraint
STAY (Grimshaw 1997, Speas
1997)

“Do not move” Leaving material in canonical
position helps the hearer to
identify grammatical
relationships and reduces
processing costs for the
speaker

TELEGRAPH (Pesetsky 1998) “Do not pronounce function
words”

Leaving out function words
reduces pronunciation costs
for the speaker in a way that is
minimally disruptive for
understanding by the hearer

RECOVERABILITY (Pesetsky
1998)

“A syntactic unit with
semantic content must be
pronounced unless it has a
sufficiently local antecedent”

Omitting a meaning-bearing
element in pronunciation
makes the hearer’s task of
extracting the intended
meaning from the speech
signal very difficult unless it
can be inferred from the
context

Table I
Some OT constraints and their possible functions

(20) Thematic Hierarchy Agent > Beneficiary > Recipient/ Experiencer >
Instrumental > Theme/ Patient > Location

(21) Relational Hierarchy Subject > Direct Object > Indirect Object >
Oblique > Genitive >Object of Comparative

(22) Animacy Hierarchy 1st Person Pronoun > 2nd Person Pronoun > 3rd Person
Pronoun > Proper Noun > Human Common Noun > Animate Common
Noun > Inanimate Common Noun

(23) Person Hierarchy Local (1st, 2nd) > 3rd
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(24) Prominence Hierarchy Discourse Prominent > Not Discourse Prominent

(25) Relational: Subject > Object > Oblique
(26) Person: Local (1st, 2nd) > 3rd

(27) Thematic Role: Agent > Patient
(28) Prominence: Discourse Prominent (X) > Not Discourse Prominent (x)

(29) a. *Su/Pat
b. *Su/x
c. *Obl/Local

(30) a.  *Su/Pat » *Su/Ag
b.  *Su/Ag » *Su/Pat

V(Agt/3/x,Pat/1/X) *Su/x *Su/Pat *GR/Pers
ACTIVE
Agt/Su/3/x-Pat/Oj/1/X

*! **

+PASSIVE
Pat/Su/1/X-Agt/Obl/3/x

* **

Tableau VII
English (prominent patient) (Aissen 1999: 689)

(31) Animacy:  Human > Animate > Inanimate
(32) Definiteness: Personal Pronoun > Proper Noun > Definite NP > Indefinite
Specific NP > Non-specific NP

(33) a.  *Oj/Hum » *Oj/Anim » *Oj/Inam
b.  *Oj/Pro » *Oj/PN » *Oj/Def » *Oj/Spec »!*Oj/NSpec

(34) *øC ‘Star Zero’: Penalizes the absence of a value for the feature CASE.

Local conjunction of *øC with the
subhierarchy on object animacy (34a)

Local conjunction of *øC with the
subhierarchy on object definiteness
(34b)

*Oj/Hum & *øC »
*Oj/Anim & *øC »
*Oj/Inam & *øC

*Oj/Pro & *øC »
*Oj/PN & *øC »
*Oj/Def & *øC »
*Oj/Spec & *øC »!
*Oj/NSpec & *øC

Table II
Local conjunction of *øC  with object-oriented subhierarchies (Aissen 2000: 9)

(35) *STRUCC: penalizes a value for the morphological category CASE

Hebrew specific, indefinite patient
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Patient: specific indefinite *Oj/Def & *øC *STRUCC *Oj/Spec & *øC *Oj/NSpec & *øC
Oj: specific indefinite
CASE: ACC

*!

+Oj: specific indefinite
CASE: none

* *

Tableau VIII
Hebrew specific indefinite patients (Aissen 2000: ms., p. 14)

Turkish specific, indefinite patient
Patient: specific indefinite *Oj/Def & *øC *Oj/Spec & *øC *STRUC

C
*Oj/NSpec & *øC

+Oj: specific indefinite
CASE: ACC

*

Oj: specific indefinite
CASE: none

*! *

Tableau IX
Turkish specific indefinite patients (Aissen 2000: ms., p. 15)

(36) NO LEXICAL HEAD MOVEMENT: A lexical head cannot move

(37) LEFT EDGE (CP): The first pronounced word in CP is a function word
related to the main verb of that CP

(38) a.  Je crois que Pierre a faim.
b.  *Je crois Pierre a faim.

(39) a.  I found a book for you to think about.
b.  *I found a book you to think about.

name grammatical constraint corresponding user constraint
NO LEXICAL HEAD
MOVEMENT (Grimshaw
1997)

“A lexical head cannot move” Moving a lexical head away from
its dependents makes it difficult
for the hearer to pair heads and
dependents

LEFT EDGE (CP) (Pesetsky
1998)

“The first pronounced word in
CP is a function word related
to the main verb of that CP”

Not explicitly marking
embedded clauses in terms of
their boundaries and finiteness
impedes rapid recognition of
their meaning and role

Table Ia
Possible functions for NO LEXICAL HEAD MOVEMENT and LEFT EDGE (CP)

(40) OP-SPEC: Syntactic operators must be in specifier position
(41) HEAD-RIGHT: Heads uniformly follow their complements and adjuncts

(42) a.  GEN-N: Mary’s mother’s uncle’s lawyer
b.  N-GEN: the leg of the table
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(43) The functional differentiation of the genitive in Early Modern English (Kroch
1994; Rosenbach and Vezzosi 2000)

a. GEN-N began to be favored for animate genitives
b. N-GEN  began to be favored for inanimate genitives

(44) a. the table’s leg
 b. the treachery of the enemy

(45)  Pressures for maintaining both the GEN-N and N-GEN orders in English:
a. The pressure of conventionality.
b. The pressure to have animate specifiers and inanimate complements
c. Purely structural pressure, caused by the existence of noun phrases with

the structure [NP’s N] and [N of NP] where there is no semantic possession at all:
i.  Tuesday’s lecture
ii.  the proof of the theorem

(46) Versions of the Thematic Hierarchy:
a. Fillmore 1968: 33

Agent > Instrumental > Objective

b. Jackendoff 1972
Agent > Location/ Source/ Goal > Theme

c. Ostler 1980
(relational predicates) Theme > Goal > Source > Path
(actional predicates) Source > Path > Theme > Goal

d. Givón 1984: 139
Agent > Dative/ Beneficiary > Patient > Locative > Instrument/

Associative > Manner

e. Kiparsky 1985: 20
Agent > Source > Goal > Instrument > Theme > Locative

f. Carrier-Duncan 1985: 7
Agent > Theme > Goal/ Source/ Location

g. Larson 1988: 382-383
Agent > Theme > Goal > Location (and other obliques)

h. Wilkins 1988: 211
Agent > Patient > Location/ Source/ Goal > Theme

i. Randall 1988: 138 (for effects of lexical rules on argument structure)
Theme > Agent > Instrument/ Source/ Path/ Goal/ Location/ …

j. Bresnan and Kanerva 1989: 23; Bresnan and Moshi 1990: 169; Alsina 1996:
688
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Agent > Beneficiary > Recipient/ Experiencer > Instrumental > Theme/
Patient > Location

k. Baker 1989: 544
Agent > Instrument > Patient/ Theme > Goal/ Location

l. Grimshaw 1990: 8
Agent > Experiencer > Goal/ Source/ Location > Theme

m. Jackendoff 1990: 261
Agent > Patient/Beneficiary > Theme > Source/ Goal/ Reference Object >

Identificational Goal/ Reference Object

n. Langacker 1990
Agent > Instrument > Patient/ Mover/ Experiencer (‘Energy Flow

Hierarchy’ for subject choice)
Agent > Experiencer > Other (‘Initiative Hierarchy’)

o. Speas 1990: 16
Agent > Experiencer > Theme > Goal/ Source/ Location > Manner/ Time

p. Dowty 1991; Rugemalira 1994
Proto-Agent > Proto-Patient

q. Kiefer 1995
Actor > Agent > Beneficiary > Theme/Patient > Instrument

r. Van Valin and Lapolla 1997: 127 (continuum in terms of LS (=logical
structure) argument positions) — this is an elaboration of Foley and Van Valin
1984:59:

Agent > Effector/ Mover/ User/ etc. > Location/ Perceiver/ Cognizer/
Experiencer/ etc. > Theme/ Stimulus/ Implement/ etc. > Patient/ Entity

A controller might be an Agent (47a), an Addressee (47b), a Patient (47c), a
Recipient (47d), a Source (47e), or a Holder (47f) (the controller is identified in
bold-face):
(47) a.  Mary attempted to take a vacation.

b.  Bill told Mary to come visit him.
c.  I persuaded John to see the doctor.
d.  We taught the dog to roll over.
e.  Sam promised Mary to write more often.
f.  Tom required Alice to hand in the assignment.

(48) Relational Hierarchy: Subject > Direct Object > Indirect Object >
Oblique > Genitive >Object of Comparative

(49) a.  John kills the ducklings.
b.  The ducklings are killed by John.
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(50) The higher in prominence a direct object, the more likely it is to be overtly
case marked.

(51) Animacy Hierarchy: 1st Person Pronouna > 2nd Person Pronounb > 3rd

Person Pronounc > Proper Nound > Human Common Noune > Animate
Common Nounf > Inanimate Common Noung

(52) Definiteness Hierarchy: Personal Pronouna > Proper Nounb > Definite NPc
> Indefinite Specific NPd > Non-specific NPe

(53) Grammars in which object case is overtly marked choose a point on the
Animacy and/or Definiteness Hierarchies and mark case at that point and at
every point of higher prominence.

(54) a. Hebrew: Object case-mark point c on the Definiteness Hierarchy.
b. Turkish: Object case-mark point d on the Definiteness Hierarchy.

(55) If an individual can lift a weight of x pounds, then he or she can lift a
lighter weight.

(56) a. Smith can lift 200 pounds.
b. Jones can lift 300 pounds.
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8.  KAYNE’S ANTISYMMETRIC PROGRAM AND TYPOLOGY

(1) Kayne’s Linear Correspondence Axiom (LCA) (informally stated)
The asymmetrical c-command relation among non-terminal nodes
uniquely determines the ordering relation among terminal nodes.
Asymmetrical c-command translates into linear precedence.

The following structure is well-formed according to the LCA:
(2)  S

 J L

j M N

m P

p

Asymmetrical c-command relations: <J,M>, <J,N>, <J,P>, <M,P>
j precedes m, j precedes p, and m precedes p, as required

But the following structure is ill-formed:
(3)  S

 J L

j M P

m p

The asymmetrical c-command is <J,M>, <J,P>, so no ordering is specified
between m and p

An important consequence: specifiers cannot be sisters to heads:
(4) *           S

NP VP

N V NP

I see N

John

The problem is that VP asymmetrically c-commands (the first) N and (the first)
NP asymmetrically c-commands V. So no unique ordering is specified for I and
see.

Solution: specifiers are adjoined to heads:
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(5)         XP

NP XP

N V NP

I see N

John

C-command is defined so that the lower XP does not c-command N in this
structure. So a unique ordering I see is defined

The LCA also prohibits two clitics from being adjoined to the same head:
(6) Jean vous le donnera

Jean you-DAT it will-give
‘Jean will give it to you’

(7)* V

CLa V

vous CLb V

le donnera
Problem: no linear order is specified for CLa and CLb  because neither K nor Q is
dominated by V. So K and Q c-command each other (i.e. there is no asymmetrical
c-command). The only solution is to say that one clitic is adjoined to the other:

(8) V

CLb V

CLa CLb donnera

vous le

CLa now asymmetrically c-commands CLb, so vous precedes le.

The following (9) is impossible because see c-commands John but does not
precede it. In other words, there can be no SOV languages!:
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(9) * S

NP VP

N NP V

I N see

John

(10) Support for the idea that there is a universal Specifier-Head ordering (p. 35)
a. Wh-phrases are almost always initial
b. Subjects are almost always initial
c. Most agree that VSO languages derive from SVO order

Kayne on the derivation of object-initial orders:
From the present perspective, OSV would involve movement of the O
past S to the specifier position of a higher head. OVS and VOS must not
have S in a final specifier position, but must instead either have OV or VO
moving as a unit leftward past S, or else V and O moving separately
leftward past S, with the expectation, then, that such languages should show
OVSX and VOSX orders. (Kayne, p. 36, emphasis added)

(11) In other words:
a. SVO -> OSV
b. S[VO] -> VOS or SVO -> OSV -> VOS
c. S[VO] -> S[OV] -> OVS or SVO -> VSO -> OSV

All complement-head ordering must result from movement — even
postpositions have to start out as prepositions

(12) Funct Proj

PP

P NP

(13) Greenberg’s Universal 33: When number agreement between the noun
and verb is suspended and the rule is based on order, the case is always
one in which the verb precedes and the verb is in the singular. (Greenberg
1963: 94)
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(14) CP

[spec, CP] C'

     IP C IPt

(15) 3 arguments for movement of IP into Spec, CP to derive final
complementizers (Kayne, p. 53-54):

a. There are no that-trace effects in languages with final
complementizers (*Who did you think that would win?). Perhaps such effects result
from the complementizer asymmetrically c-commanding the subject, which
would not be the case if IP is in Spec, CP.

b. Languages with final complementizers allow nominative anaphors,
but complementizer-initial languages do not. Perhaps the movement of IP to
Spec,CP licenses the nominative anaphor by removing it from the c-command
domain of the complementizer.

c. In general ,COMP-final langs do not allow wh-movement. If  final
complementizers arise from movement of IP into SPEC,CP, wh-movement is
thereby denied a landing site.

Further development in Cinque 1996

(16) Greenberg’s Universal 20: When any or all of the items (demonstrative,
numeral, and descriptive adjective) precede the noun, they are always
found in that order. If they follow, the order is either the same or its exact
opposite. (Greenberg 1963: 87)

Greenberg’s universal is given much more detail in Hawkins 1983:
(17) For prepositional languages:

a. NDem & NA (Swahili, Fulani, Bahasa Indonesian, …)
b. DemN & NA (Maori, Baure, Douala, Tunen, …)
c. DemN & AN (Greek, Maya, Norwegian,…)
d. *NDem & AN

e. NNum & NA (Swahili, Douala, Tunen,…)
f. NumN & NA (Maori, Baure, Bahasa Indonesian)
g NumN & AN (Greek, Maya, Norwegian)
h. *NNum & AN

(18) For postpositional languages:
a. NDem & NA (Selepet, Mojave, Diegueño, …)
b. DemN & NA (Burmese, Kabardian, Warao, …)
c. DemN & AN (Burushaski, Hindi, Japanese,…)
d. *NDem & AN

e. NNum & NA (Selepet, Mojave, Kabardian, Warao…)
f. NumN & NA (Burmese, Hixkaryana, Ubykh)
g NumN & AN (Burushaski, Hindi, Japanese,…))
h. *NNum & AN
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In other words, postpositional languages actually follow the same ordering
restrictions. Cinque handles this by assuming that universal basic order is:

(19) XP

XP YP

X Dem YP

Y WP

Swahili Num WP

Douala W ZP

Adj ZP
    Maori

Z NP

N

(20) What can happen in postpositional languages?
a. Nothing — you get Dem-Num-Adj-N as in Hindi
b. You can have successive leftward movements of the complements
of the functional heads Z, W, and Y:

(21) XP

XP YP

X Dem YP
Y WP

Num WP
#3

W ZP

Adj ZP

Z NP
#2

N
#1
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(22) If all steps apply, you get N Adj Num Dem (the mirror image order)

(23) Independent support for these movements is provided by the fact that
intermediate steps appear to exist:
a. Steps #1 and #2 only: Dem N Adj Num (Kabardian, Warao)
b. Step #1 only: Dem Num N Adj (Burmese, Kokama, Ubykh)

Lots of footnotes with potential problems that he has an answer for

— NDem & NumN should be impossible, but it is attested (Berber, Hebrew,
Welsh, Zapotec). He suggests that the configuration in (21) and that
demonstratives might be moved to that position

— Step #2 of (21) cannot apply unless step #1 has applied (or you would
generate unattested Adj N Num Dem)

— For some reason, postpositional languages have leftward XP movements,
but no leftward movement of just the N; whereas prepositional languages
have N raising, but no leftward XP movement. Why?

REFERENCES
Cinque, Guglielmo (1996) 'The 'Antisymmetric' Program: Theoretical and Typological

Implications', Journal of Linguistics, 32: 447-465.
Craig, Colette (1977), The Structure of Jacaltec (Austin, TX: University of Texas Press).
Greenberg, Joseph H. (1963), 'Some Universals of Language with Special Reference to the Order

of Meaningful Elements', in J. Greenberg (ed.), Universals of Language (Cambridge, MA:
MIT Press),  73-113.

Hawkins, John A. (1983), Word Order Universals (New York: Academic Press).
Kayne, Richard S. (1994), The Antisymmetry of Syntax (Cambridge, MA: MIT Press).



Newmeyer Handout #3

16

9.   SPLIT-CP HYPOTHESIS

(1) CP[SPEC,CP C'[C IP[SPEC,IP I'[I VP … (The mid-1980s consensus)

(2) aP[SPEC, aP a'[a bP[SPEC, bP b'[b gP[SPEC, gP g'[g … IP … (The Split-CP
Hypothesis)

Three proposals leading to the Split-CP Hypothesis
(3) a. There is no optionality in grammar; hence elements move only
when they are ‘required to’ (Chomsky 1995)

b. Movement must be triggered by a feature on a functional head
(Chomsky 2000)

c. Features of the ‘peripheral system’ (force, topic, focus, etc.) trigger
A' movement (Chomsky 2000).

Syntactic movement … must be triggered by the satisfaction of certain quasi-
morphological requirements of heads. … [S]uch features have an
interpretive import (Wh, Neg, Top, Foc, …): they determine the
interpretation of the category bearing them and of its immediate
constituents …, function as scope markers for phrases with the relevant
quantificational force in a local configuration, etc. … (Rizzi 1997: 282)

(4) ForceP Rel pronouns are in Spec of ForceP

Force0      TopP*

Top0     FocP Interrog  pronouns are in Spec of FocP

Foc0     TopP*

      Top0 FinP

   Fin0          IP
(Rizzi 1997; see also Hatakeyama 1997 for a similar proposal)

(5) Credo che a Gianni, QUESTO, domani, gli dovremmo dire
      C        Top Foc    Top    IP

‘I believe that to Gianni, THIS, tomorrow we should say’

The LF-encoding of information structure (Rizzi 1997):
(6) a.  Top0 [Comment]
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b.  Foc0 [Presupposition]
Some ordering restrictions on the left-periphery:
(7) a.  the man to whom liberty, we could never grant (Baltin 1982)

b.  *the man, liberty, to whom we could never grant
(8) a.  On the table, which dishes are you going to put?

b.  *Which dishes are, on the table, you going to put? (Culicover 1991a)

(9) a. NP

NP CP

        the man   Spec, CP IP         

   to whomj  NP  IP

    libertyi  NP VP

      we   could never grant ti  tj

b. NP

NP CP

        the man     NP           CP         

   libertyi  Spec,CP  IP

    to whomj  NP VP

          we could never grant ti   tj
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(10) a. CP

PP CP

on the tablei Spec, CP IP

   which dishesj

are you going to put tj  ti

b. CP

     Spec, CP          CP

which dishesj     PP            IP

   on the tablei

are you going to put tj  ti

(11) The Nested Dependency Constraint (Fodor 1978; 1984; Pesetsky 1987): 
Multiple filler-gap dependencies may be disjoint or nested, but not

intersecting.

(12) LF Focus Movement (Chomsky 1976; Chomsky 1981)

Focuses, but not topics, give rise to weak cross-over effects (Lasnik and
Stowell 1991; Culicover 1991b; Rizzi 1997):
(13) a.  Johni, hisi mother loves ti (John a topic)

b.  *JOHNi hisi mother loves ti (not Paul) (John a focus)

In situ focus generating weak cross-over effects (Lappin 1982, Lasnik and
Stowell 1991):
(14) ??Hisi mother shot JOHNi

Focused NPs in ungoverned islands (Reinhart 1991; Horvath 1999)
(15) a.  [IP [CP That Linda argued with THE CHAIRMAN] is surprising].

b.  [IP [NP Even the paper that LUCIE submitted to our journal] was weak].
(16) Q.  Do people wonder where Mary was last night?

A.  No, people wonder where [Mary’s BOYFRIEND] was last night.
(17) Q.  Have you shown Bill the book that I gave you for your birthday?

A.  No, I have (only) shown him the book that you gave me for
CHRISTMAS.
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Even if covert pied-piping were permitted, it shouldn’t apply in sentences (16)
and (17), since if we substitute a wh-word for the focus, pied-piping is impossible:
(18) a.  *Whose boyfriend do people wonder where was last night?

b.  *For what (holiday) did you show him the book that you gave me?

… an apparent alternative would be to determine focus and presupposition in
terms of surface structure: the focus is the phrase containing the
intonation center, and the presupposition is determined by the
replacement of the focus by a variable … (Chomsky 1971: 200).

(19) Was he warned to look out for [an ex-convict with a red shirt]?
               SHIRT
          RED SHIRT
      A RED SHIRT

         WITH A RED SHIRT
 EX-CONVICT WITH A RED SHIRT

         AN EX-CONVICT WITH A RED SHIRT

Non-phrasal occupants of left branches can be contrastive foci (Ladd 1978;
Lambrecht 1994):
(20) Q. Has John read Slaughterhouse-Five?

A.  No, John doesn’t READ books.
(21) Mary is THE boss.

A sentence can have multiple/discontinuous  focuses (Jacobs 1984;  1988;  1992; Rooth
1985; Stechow 1989; Krifka 1991)

(22) Q: Did Mary wash the car?
A: No, TOM washed the WINDOWS.

A prefix can be a focus (Chomsky 1971)
(23) John is more concerned with AFfirmation than with CONfirmation.

(24) I gave [to Mary] [all my books on the phonetic foundations of
conventional implicature]. (Heavy-NP-Shift)

But a heavy NP is not necessarily in focus:
(25) a.  To whom did you give all your books on the phonetic foundations of
conventional implicature?

b.  I gave [TO MARY][all of those unbelievably ridiculous publications].

(26) Focus in Aghem (Watters 1979 and Horvath 1995)
a.  f¤¤¤¤¤¤¤¤ˆ¤l a¤ mç› zˆ¤ GKE» bE¤÷»kç¤
     friends SM P2 eat WHERE fufu

‘Where did the friends eat fufu?’

b.  f¤¤¤¤¤¤¤¤ˆ¤l a¤ mç› zˆ¤ ÁN 'SÓM bE¤÷»kç¤
     friends SM P2 eat IN FARM fufu

‘The friends ate fufu IN THE FARM’
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(27) Háizi ba& shu) ma&i le (Chinese)
child obj. marker book buy asp.
‘What the child did to the book was buy it’

In Malayalam, question words moved immediately to left of V, but have scope
over the entire sentence:

(28) a.  ninº-÷nºe aar´ talli (Jayaseelan 2002)
    you-acc. who beat (past)

‘Who beat you?’

b.  * aar´ ninº-÷nºe talli
      who you-acc beat (past)

(29) Wh-Criterion (Rizzi 1996: 64; revising May 1985):
A. A wh-operator must be in a Spec-head configuration with X0 [+wh}
B. An X0 [+wh] must be in a Spec-head configuration with a wh-operator

(30) I think that, tomorrow, John will leave

In most languages, where fronted wh-phrases and the that complementizer
cooccur, the wh-phrase precedes the complementizer:

(31) What that I mene, O swete herte deere? (Middle English — Sobin 2002)

‘What do I mean, oh dear sweetheart?’

(32) There is extensive variation in what can occur on the left-periphery and
where:

a. Some languages allow a single position on the left periphery, which
can house either a focus or a topic, but not both (Lopez 2002; Vilkuna 1995)

b. In Zapotec, displaced wh-elements and displaced focus-elements
can cooccur, despite that fact that Rizzi’s model they are supposed to target the
same projection (Lee 2001)

(33) For the advantages of an adjunction approach to topicalization over a
TopP analysis, see Lasnik and Saito 1992.

‘Minimalist’ alternatives to triggered focus movement:
(34) a. Erteschik-Shir 1997: Topic and focus constituents are marked at ‘F-
structure’, an annotated S-structure. The rule of predication takes F-structures as
input and produces well-formed discourse representations.

b. Fox 1995; Reinhart 1997 (based on Cinque 1993’s theory of phrasal
stress): Focus is not encoded in the syntactic derivation, but arises exclusively at
the PF interface. ‘Interface economy’ explains why elements not in canonical
position can be stressed focuses. (See also a parallel optimality-theoretic account
in Szendröi 2001.)
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NO OBVIOUS PRINCIPLE SEEMS TO DISTINGUISH MOVEMENT IN THE
NARROW (S-)SYNTAX FROM MOVEMENT IN THE  P-SYNTAX

Three scenarios for movement:
(35) a. Best scenario— all movement is in the narrow (S-)Syntax

b. Acceptable scenario— some principle distinguishes S-Syntactic
movement from P-Syntactic movement

c. Unacceptable scenario— no principle distinguishes S-Syntactic
movement from P-Syntactic movement

Heavy NP-Shift licences parasitic gaps (Engdahl 1983):
(36) John offended t by not recognizing e immediately, his favorite uncle from
Cleveland.

PP Extraposition creates configurations relevant for anaphor-antecedent
binding (Guéron 1980):
(37) a.  a picture of Mary was sent to her

b.  *a picture was sent to her of Mary
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